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CAUTION:

® Operate this equipment according to the operating procedures described in this manual.

® Use only the provided CD-ROM. Never use any other CD-ROM to run this software.

® Do not attempt to modify this software.

® Changes or modifications not approved by JVC could void user’s authority to operate the equipment.

How to handle a CD-ROM

® Take care not to soil or scratch the mirror surface (opposite to the printed surface). Do not write anything
or put a sticker on either the front or back surface. If the CD-ROM gets dirty, gently wipe it with a soft
cloth outward from the center hole using a circular motion.

® Do not use conventional disc cleaners or cleaning spray.

® Do not bend the CD-ROM or touch its mirror surface.

® Do not store your CD-ROM in a dusty, hot or humid environment. Keep it away from direct sunlight.

® The Readme.TXT file provides additional information for setup and information that is not included in the
instruction manual. Please read the file before using the provided software program.

® You can find the latest information (in English) on the provided software program at our world wide web
server at http://www.jvc-victor.co.jp/english/index-e.html

® Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the
United States and/or other countries.

® Macintosh is a registered trademark of Apple Computer, Inc.

® Keyspan is a trademark of InnoSys Inc.

® Other product and company names included in this instruction manual are trademarks and/or registered
trademarks of their respective holders.



4 N INTRODUCTION

I Reading this document

This document consists of the following three sections and an Appendix.
Before use, please read the Setup Guide for preparation.

m Loading Still Images (Windows®)

This section explains how to capture images from the camcorder tape to the PC, or capture images from the
camcorder in real time. This section also explains how to load still images into the album of the Digital Photo
Navigator software.

m Playing Back and Handling Images (Windows®)

This section explains how to handle still images using the Digital Photo Navigator software. You can send still
images by e-mail and store an album as a web page.

m Digital Photo Navigator (Macintosh)

This section explains how to capture images from the camcorder tape to the PC, or capture images from the
camcorder in real time.

m Appendix

This appendix contains troubleshooting and index.
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Loading Still Images (Windows®)

You can capture still images from the recorded camcorder tape, from the
camcorder in real time, or load still image files from the hard disk in the
PC. The Digital Photo Navigator software allows you to store and view still
images in a photo album format.

The icons on the Digital Photo Navigator window have the same functions
as the menus. In this section, almost all the procedures are explained using
the icons.

Read this section if you are using a Windows® operating system.

[>~Digital Photo Navigator [_[Ofx]
Menus File Edi Impot Expor Window Help
kwd
Import ¥ Export
I [ —
cons — )2

Alburm Image

@

Camcorder




6 N CAPTURING IMAGES

You can capture still images from the recorded camcorder tape, from the camcorder in real time, or load still
image files from the hard disk in the PC. After capturing or loading images, create an album that contains a
collection of still images.

Preparation
1 Connect the camcorder to the PC with the PC connection cable.
® Refer to “CONNECTIONS (Windows®)” in the Setup Guide.

2 Select [Start] — [Programs] — [Digital Photo HewOfesDacmen

Navigator] — [Digital Photo Navigator 1.0]. %0“"0"‘520““”2"

Digital Photo Navigator starts.

® Close any other programs running on the PC.

® Disable any programs that run in the background, such
as screen savers, e-mail applications, virus checkers,
schedulers, etc.

® Turn off file and printer sharing.

I Capturing still inages from tape

You can capture still images from the camcorder tape on the PC.

1 Set the Power Switch on the camcorder to “ E¥X”.
The camcorder is now on.

2 Click [Import]. B o e s
3 Click [Camcorder]. The Controller window appears. =44

NOTE:
If the camcorder is not connected to the PC, the camcorder is
turned off, or the camcorder is connected to any serial port Seial Pot Picue Transfer Fate
other than COMT, the [JLIP Devices] dialog box appears. covt = s 7
1) Connect the camcorder to the PC with the PC connection Selested Devics
cable. oR|1D:06 VHSCAM ﬂl
® Refer to “CONNECTIONS (Windows®)” in the Setup Sger|Me Device s
Guide. . Ne. |ID [Categoys  |Name | Scan
2) Set the Power Switch on the camcorder to “ NS ". Mot Connected
The camcorder is now on. 1 6 Commmdy WHEOM
3) Select the appropriate setting for [Serial Port] depending on
the port in use.
4) Click [Scan]. o |

5) If the camcorder name [VHSCAM] appears, click [OK].

CONTINUED ON NEXT PAGE



CAPTURING IMAGES (cont.) EN /

4 Click the B button in the Controller window.
® Playback of the camcorder tape starts.

S Click the Capture button when the desired image
appears.
® The image is transferred to the PC and thumbnail image
appears to the right-hand side of the Digital Photo
Navigator window.

Capture

6 Repeat steps 4 and 5 to capture additional images.
® |t is possible to capture or add up to two hundred images into an album.

7 Click [Export] after capturing is completed. [0 i s BRE

8 Click [Album].
The [Save As] dialog box appears.

9 Specify the location where you want to save the
album, input the file name of the album, and then
click [Save].

The album is saved.

web
Page

a
e
o If you save an album for the first time after the software
installation, a message appears and asks if you want to () I e s e o
register the association of the file extension name “jia”. PO G e
Then, click [Yes]. [ oves Mo

® To exit Digital Photo Navigator, refer to “Exiting Digital
Photo Navigator” (= pg. 15).
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Controller window

Fast Forward (p)

Tape counter

Play () Close

Rewind (44)
Automatic Capture
Pause (1)

Slow Rewind* Capture

Reverse Frame Advance*

Slow Forward*

Stop (W) Forward Frame Advance*

* This function is not available with VHS-C camcorders.

NOTES:

® Use only the operation buttons in the Controller window to control the camcorder. If you operate the
camcorder with its own operation buttons, the appearance of the Controller window may not correspond to
the status of the camcorder, or it may cause a malfunction to occur in Digital Photo Navigator.

® The Controller window may appear to still be operating the camcorder even after the videocassette
automatically stops at the beginning or end of the tape. In this case, click the Stop (B) button in the
Controller window before performing another operation.

® [f an image is captured in the Pause or Slow Play mode, some noise may appear on the captured image. In
this case, capture the image during normal playback.

I Automatic Capture

You can automatically capture still images from the camcorder tape on the PC according to your preferences.
There are 2 ways available: “Photo Capture” and “Interval Capture”.

1 Set the Power Switch on the camcorder to “ E¥X”.
The camcorder is now on.

2 Click the ® button in the Controller window.

3 Click the Automatic Capture button. >
The camcorder enters still playback mode. Automatic
Capture

CONTINUED ON NEXT PAGE



CAPTURING IMAGES (cont.) EN 9

4 Co to steps in “Photo Capture” or “Interval Capture” below.
NOTES:

® Depending on your PC’s specifications and operating environment, the points where images are captured
may not match what was set in the preferences.

® |f the videotape is damaged, the points where images are captured may not match what was set in the
preferences.

® Automatic capture may not function properly if portions of the videotape are unrecorded.

® Automatic Capture may not function properly when, for example, you capture images recorded after the
recording speed was changed. In these cases, capture images by performing the steps in “Capturing still
images from tape” (= pg. 6).

® Automatic capture stops when the number of images in the right-hand side of the Digital Photo Navigator
window reaches 200 or the videotape ends.

Photo Capture
You can capture only snapshot images recorded on a tape.
1 Select [Photo Capture] in the Automatic Capture

window. & Fhoto Copture Nurmber of Images
2 Set the number of images to be captured. N ooty o =
3 Click [OK]. The camcorder starts forward search and " nervel Captuae
capturing is performed when each snapshot image is wn_am —
found out. N |
® If you want to start the search from beginning of a tape,
select [Rewind the tape] before clicking [OK]. Number of images
4 Click [Export] after capturing is completed. Rt st e B

S Click [Album]. v
The [Save As] dialog box appears.

6 Specify the location where you want to save the
album, input the file name of the album, and then
click [Save].

The album is saved.

web
Page

5 o7 008

Change
Format

o If you save an album for the first time after the software
installation, a message appears and asks if you want to
register the association of the file extension name “jia”.
Then, click [Yes].

® To exit Digital Photo Navigator, refer to “Exiting Digital
Photo Navigator” (= pg. 15).

NOTE:

Photo Capture may not function properly when, for example, the camcorder tape includes snapshot images
recorded after the recording speed was changed, or when snapshot images were continuously recorded. In
these cases, capture images by performing the steps in “Capturing still images from tape” (= pg. 6).

The file extension name 'jia' dossrit assaciate with this praerar

Do you want to register the association now?




10~

CAPTURING IMAGES (cont.)

Interval Capture

You can capture images at specified intervals. This function is useful for summarizing the contents of a tape,

or for watching time-lapse movies using the slide show.

1 Select [Interval Capture] in the Automatic Capture
window.

2 Set the number of images to be captured.

3 Set the length of the interval (in minutes and
seconds).

4 Click [OK].

5 Click [Export] after capturing is completed.
6 Click [Album].
The [Save As] dialog box appears.

7 Specify the location where you want to save the
album, input the file name of the album, and then
click [Save].

The album is saved.

o If you save an album for the first time after the software
installation, a message appears and asks if you want to

register the association of the file extension name “jia”.

Then, click [Yes].
® To exit Digital Photo Navigator, refer to “Exiting Digital
Photo Navigator” (= pg. 15).

NOTE:

¢ Photo Capture Number of Images

™ Rewind the tape 15 2

* Interval Capture

_IG l@ Cancel

Length of the interval Number of images

[>Digital Photo Navigator 5]
File Edit Ipaage Export Window Help

Y ol |
i
EMal Ml
Image
web Mavie
Page =
5 o7 008

Change
Format

The file extension name 'jia’ doesn't associate with this program
Do you want ta register the association now?

This function doesn’t work if the recording time on the tape is shorter than 1 minute.
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I Capturing still inages from the camcorder in real time

You can capture still images in real time, from the camcorder to the hard disk in the PC.

1 Set the Power Switch on the camcorder to “B” or “M”.
The camcorder is now on.

2 Click [Import]. e — —
3 Click [Camcorder]. The Controller window appears. R

NOTE:
If the camcorder is not connected to the PC, the camcorder is g
turned off, or the camcorder is connected to any serial port Seril Pot Picture Transfes Rate
other than COMT1, the [JLIP Devices] dialog box appears. cowt @] fisan 7]
1) Connect the camcorder to the PC with the PC connection Selected Davics
Cab[e. VCR |10:06 VHSCAM Seleat
® Refer to “CONNECTIONS (Windows®)” in the Setup Gean[Ho Device: Selent
Guide. . No. [ID |Category | Name | Sean
2) Set the Power Switch on the camcorder to “BY” or “[M) ”. Not Connected
The camcorder is now on. ! _
3) Select the appropriate setting for [Serial Port] depending on
the port in use.
R ancel
4) Click [Scanl. e |

5) If the camcorder name [VHSCAM] appears, click [OK].

4 Click the Capture button when the desired image
appears.
® The image is transferred to the PC and thumbnail image
appears to the right-hand side of the Digital Photo
Navigator window.

S Repeat step 4 to capture additional images.

Capture

CONTINUED ON NEXT PAGE
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CAPTURING IMAGES (cont.)

6 Click [Export] after capturing is completed.

7 Click [Album].

The [Save As] dialog box appears.

8 Specify the location where you want to save the
album, input the file name of the album, and then
click [Save].

The album is saved.

o |f you save an album for the first time after the software
installation, a message appears and asks if you want to
register the association of the file extension name “jia”.
Then, click [Yes].

® To exit Digital Photo Navigator, refer to “Exiting Digital
Photo Navigator” (= pg. 15).

I Changing the transfer speed

[>Digital Photo Navigator 5]
File  Edit oy Export  Window Help

Y ol |
i
EMal Ml
Image
web Mavie
Page =
5 o7 008

Change
Format

Digital Phots

The file extension name 'jia' dossn't sssociate with this proeram
Do you want to register the association now?

Yes Mo

The default setting is 115200bps. Depending on the PC in use, transmission errors may occur. In this case,
change to a lower serial speed setting, however, the rate of image transfer will be slower.

1 Right-click the Controller window and then, in the menu that appears, click [Device Setting].

The [JLIP Devices] dialog box appears.
2 Select the desired setting for [Picture Transfer Ratel].

3 Click [OK].

Serial Port Picture Transfer Rate

oMl =] [riszm =]
Selected Device
R [ID:06 WH5CAR SEE
Span|Mo Device SHED,
No. |ID |Categons  Mame [ S|

Mot Connected

1 08 Camcoder  WHSCAM

Cancel
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You can load the still image files (bitmap or JPEG format) from the hard disk in the PC to an album.
1 Start Digital Photo Navigator.

2 Click [Import]. —
3 Click [Image]. =

The [Open] dialog box appears.
4 Open the folder that contains the desired still images. g

Camcorder

Open [21x]

ok [moveem Fle| @ ol 2

Remavable Disk (E)
G pemM
R }1000VCGR)
i Network Neighborhood

File narme: ?wanemase
Online Services
Files oftype:  [Image File | Cancel
4
5 Select the desired still image files and click [Open]. = Digict Phots Newigetor B

File Edit Impot Export Window Help

The still images are added to the right-hand side of m' G -
the Digital Photo Navigator window. L % E =

® You may select more than one file. a =
® You can also add files by dragging and dropping them in s
the Digital Photo Navigator window. &
6 Add additional still images as desired by repeating
steps 3 - 5.

CONTINUED ON NEXT PAGE



14 en ADDING STILL IMAGES TO AN ALBUM (cont.)

7 Click [Export]. > Digial Photo Novigotor ——

8 Click [Album].
The [Save As] dialog box appears.

9 Specify the location where you want to save the

album, input the file name of the album, and then =

click [Save]. RN

The album is saved. W_E|b| ﬁ
e

Change

o If you save an album for the first time after the software
installation, a message appears and asks if you want to T M R i e i S
register the association of the file extension name “jia”. PO I e G
Then, click [Yes]. TV | mo

® To exit Digital Photo Navigator, refer to “Exiting Digital
Photo Navigator” (= pg. 15).




EXITING DIGITAL PHOTO NAVIGATOR
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1 Click the [File] menu and then click [Exit].
o |f you have already saved an album, a confirmation message
appears. Then, go to step 2.

e If you have not saved an album after capturing or loading
still images, a confirmation message appears.
To save an album, click [Yes]. The [Save as] dialog box
appears. Specify the location where you want to save the
album, input the file name of the album, and then click
[Save]. A confirmation message appears. Then, go to step 2.
To exit Digital Photo Navigator without saving an album,
click [No]. A confirmation message appears. Then, go to
step 2.

2 Click [Yes].
Digital Photo Navigator closes.

[ Eile”

Mew

Digital Photo Navigator =]

@ The album has nat heen saved.

Sawe ?

Yes Mo |
Digital Photo Navigator =]

@ Close Digital Photo Mavigator?




16 e~

Playing Back and Handling Images (Windows®)

This section explains how to handle still images using Digital Photo
Navigator.

You can send still image files as an e-mail attachment and store an album
as a web page. Be sure to read “Loading Still Images (Windows®)” before
reading this section.

The icons on the Digital Photo Navigator window have the same functions
as the menus. In this section, almost all the procedures are explained using
the icons.

Read this section if you are using a Windows® operating system.

[>~Digital Photo Navigator [_[Ofx]
Menus File Edit Import Export MWindow Help

b s
Import

|

Icons— Hl &

Abum Image

B ol |

a3

E-Mal Multi

Image

Webh Movie
Page
Change
Farmat.




LOADING AN ALBUM

N 1/

1 Start Digital Photo Navigator.
2 Click [Import].

3 Click [Album].
The [Open] dialog box appears.

4 Open the folder where the album was saved.

5 Click the desired album file, and then click [Openl.

The contents of the album are displayed in the right-hand
side of the Digital Photo Navigator window.

NOTES:

[>Digital Photo Navigator 5]

Wy Import Export Window  Help
.
~24
Export
i) &
Abum ) Tmage

Camcorder

Open [21x]

okin [@oveen 5@ @l o

i Network Neighborhood

File name] &3 My Briefcase
3 Online Services
Files oftype: [ image File - Cancel
4
[~ Digital Photo Navigator M=

File Edit Impot Export Window Help

bad | 2 e
Import 4 Export <

3 = ———
ﬂ a 001 002 003

Album Image

Camcorder

® You can also open the album file by dragging and dropping it in the Digital Photo Navigator window.

® [fan album is currently open, a confirmation message
appears.

* If you want to open the newly selected album instead of

the one already opened, click [Yes]. If you have not saved

the album already opened, a confirmation message
appears. If you want to save the album, click [Yes]. If you
do not want to save the album, click [No].

Digital Fhoto Navigator

@ Do you wantto delets the images already existed?

Yes Mo |

e If you want to add still images from the newly selected album to the album already opened, click [No].



I8 En DISPLAYING STILL IMAGES

I Displaying a selected still image

You can select for display any of the still images that are displayed in the right-hand side of the Digital Photo
Navigator window.
1 Double-click the still image to be displayed.

The [Image Viewer] window appears, and the selected image is displayed.

-~ Image Viewer [ Image002 35% |

[
0 R e S A

EE

I Displaying a series of images

To display a series of images in “slide show” fashion, click the | button in the [Image Viewer] window. You
can also move through the images manually in either direction by clicking the i/ and x| buttons.

Stop slide show Start slide show

[ 1| r| |>| [m |11
|

First image

Last image

Previous image Next image

To adjust the speed of the slide show, right-click the [Image Viewer] window and then, in the menu that
appears, click [Slide show] — [Setting Interval Time]. Set the length of the interval (in seconds), and then click
[OK].

NOTE:

The interval for a slide show is a little longer than the setting because of display processing time.
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I Enlarging and reducing images

The following procedure describes how to change the display size of a still image.

1 Dragthe corner of the [Image Viewer] window to change the size of the window to the desired
display size.

2 Right-click the [Image Viewer] window and then, in the Display magnification
menu that appears, click [Zoom] — [Auto].
The size of the still image is automatically enlarged or reduced to
fit the window, and the display magnification (enlargement/
reduction percentage) indicated in the title bar of the window
changes accordingly.

Other enlargement /reduction functions

In addition to adjusting the size of the image to the size of the
window, the display size of a still image can also be changed by the
methods described below. Each of these functions can be selected by
right-clicking the [Image Viewer] window.

® [Zoom] — [Real Size]: Displays the image in its original size (display magnification of 100%).

® [Zoom] — [Zoom In]: Displays the image at twice its current display magnification (up to 400%).
® [Zoom] — [Zoom Out]: Displays the image at half its current display magnification (up to 20%).




20N ORGANIZING ALBUMS

Whenever necessary, you can delete or copy still images that you have added to an album. The procedure
described below only affects the still image in the album. It does not affect the original file of the still image
that was added to the album.

I Selecting multiple still images

To delete or copy multiple still Images at once, select them in advance. You can also select all still images in
the album.

Selecting still images continuously
Click still images while holding down the Shift key.

[~ Digital Photo Navigator M=
File Edit Impon Export Window Help
A
Import

Click

Album

EMal

JEl

web
Page

3

Change
Format

Shift + Click

Selecting still images one by one
Click still images while holding down the Ctrl key.

[~ Digital Photo Navigator M=
File Edit Impon Export Window Help

A
Import

Ctrl + Click

-
E-Mail Multi
JETR
web Movie
E

Change
Format

Selecting all of the still images
Click [Select All] in the [Edit] menu.

Edit
(Euf (01t
Cpy (Lt
Paste (EfH s

elete =]




ORGANIZING ALBUMS (cont.)
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I Deleting unnecessary still images

1 Click the still image that you want to delete, and then
click [Delete] in the [Edit] menu.
A confirmation message appears.

2 Click [Yes].

The selected still images are deleted.

I Copying still images

1 Click the still image that you want to copy, and then
click [Copy] in the [Edit] menu.

2 Click the image that is located right after the
insertion point.
® To add the images at the end of the album, click the blank
space in the right-hand side of the window.
3 Click [Paste] in the [Edit] menu.
The copied still images are inserted right before the selected
image.

NOTE:
You can delete, copy or paste an image also by right-clicking it.

TEdit’
Cut Cirl+
Copy Ctrl+C
Paste (EfH s

Select All Cirl+A,
Inverse Selection

Digital Photo Navigator

@ Delete 1 Image(s) 7

Select All Cirl+A,
Inverse Selection

- Digital Photo Navigator
Eile | Edit Import Export Window Help
c cn

[_[CIx]

Insertion point
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SENDING IMAGES FROM AN ALBUM IN E-MAIL

Click the still image that you want to send, and
then click [E-Mail].

The new message window in your e-mail program
appears, and the still image file is registered as an
attachment.

NOTES:

® Depending on an e-mail software, a new message window
may not open when the [E-Mail] button is clicked.

® Depending on an e-mail software, settings such as “Set as
MAPI client” or “Used by MAPI application” are necessary.

® The maximum number of messages that can be created at
once is three.

Still images in an album can be sent as an e-mail attachment.

- Digital Photo Navigator
File Edit Impot Export Window Help

[

Impart

H =

Album Image
o1
ax

Multi
Web Mavie
Change

[_[CIx]

i New Hessage

it View Inset Fomal Took Messsge Help

[_[O]x]

@3 -l v !
Send | (i oy Pasle (i | Cheok Speling | Aloch Fiiy | Sin Encypt Offine
@ |
@mos |
Subiest |
Aach ﬁwwnnmwﬁ 108 KB) >
7 U

NS




CREATING A WEB PAGE
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You can save the contents of an album in HTML format. This is useful in the following instances:

When creating a web page: You can create a web page that features a collection of photos.
When distributing an alboum:  You can create an album in a format that can be displayed by a web
browser. This is useful if you want to distribute the album on CD-R, etc.

1 Select the still images that you want to save in HTML
format.
® To select more than one still image, hold down the Shift
key or the Ctrl key while clicking the images.
® To select all of the still images, click [Select All] in the
[Edit] menu.

2 Click [Web Pagel.
The [Web Page] dialog box appears.

3 Set the following items when necessary.

e [Title]: This will be the title of the web page.

@ [Font Color]: This specifies the color of the title text.

® [Back Color]: This specifies the background color of the
web page. (Specify a color other than the font color.)

® [Limit horizontal size of the images]: This allows you to
specify the maximum width of the image when displayed
by a web browser. (Set the number of pixels much smaller
than the width of the PC’s display.)

[~ Digital Photo Navigator M=
File Edit Impon Export Window Help
A
Import

Abum

Etal

web

Page

change

Format
Web Page [x]
Tl

My Pictures
Back Calor
Imag
¥ Limit horizortal size of the images
Masimurn pivels [0 2]

CONTINUED ON NEXT PAGE



24 BN CREATING A WEB PAGE (cont.)

4 (Click [OK], specify the save location, and then
click [Savel]. @ ﬁ,
The HTML file is saved, and a folder with the same pagelllhtm page00l
name is saved at the same time. A confirmation
message appears next, asking whether to display the

web page.
5 Click [Yes]. My Pictures - Microsoft Internet Explorer AEE
) File Edit View Favortes Tools Help ‘
The web browser opens, and the HTML file that was + . = . 0 o a 3 | B
ted iS dis ]a ed Back Farward Stop Refresh  Home Search Favorites  History Mail Print
crea p y . Address [ C:\My Documents\page001 him =] @co |[Links

® Click on an image on the web page to enlarge it.
My Pictures

& [ [ [BMWCompuer

What Next?

You can also view an HTML file through the web browser by double-clicking the HTML file. You can upload
the HTML file to your home page, or save it on a CD-R or some other media and distribute it.

Always handle HTML files and folders as a set. Without its folder, an HTML file cannot be viewed by a web
browser.

NOTES:

® For more details on how to create a home page, consult your Internet service provider’s web site or one of
the many reference books available.

® Use third-party home page creation software or similar software to edit HTML files.



CHANGING THE IMAGE SIZE OR PICTURE QUALITY

N 25

I Changing the image size

This procedure describes how to change the size of an image that has been loaded into Digital Photo
Navigator. This procedure is used to reduce the size of an image that is being attached to an e-mail or saved in

an album.

1 Select the still image to be changed.
® To select more than one still image, hold down the Shift
key or the Ctrl key while clicking the images.
® To select all of the still images, click [Select All] in the
[Edit] menu.

2 Click [Change Format].
The [Image Format] dialog box appears.

3 Select one of the following items:
® [Expansion/Reduction]: Set any desired image size in the
[Width] and [Height] fields. If the [Keep aspect ratio]
check box is not selected (off), both [Width] and [Height]
fields can be changed.
® [Generic Sizel: Select the size from a list of generic sizes.
® [PDA Size]: This is an image size (160 x 160) that can be
displayed on most PDAs.
4 Click [OK].
o [f you select more than one still image instep 1, a
confirmation message appears.

¢ If you want to apply the same format to all images, click
[Yes].

- Digital Photo Navigator
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¢ If you do not want to apply the same format, click [No]. The first image is saved. Then, select the image

size for each image.

The image size is changed to the selected size. If the vertical-to-horizontal ratio was changed, the blank

spaces are shown as black.
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I Changing the picture quality, etc.

In addition to changing the size of an image, it is also possible to rotate images, change or correct the quality
of an image, and change the file format of an image. The role of each setting is described in more detail
below.

[90 degrees Rotation]

If you hold the camcorder sideways when recording an
image, you can create an image that is taller than it is
wide. Because this still image will be displayed sideways,
use this function to rotate the image 90 degrees to the
portrait orientation.

[None]: No correction

[Clockwise]: Rotates the image 90 degrees clockwise.
[Counterclockwise]: Rotates the image 90 degrees
counterclockwise.

[Image Correction (DV)]
NOTE:

This function is not available with VHS-C camcorders.

Sometimes, when you shoot a subject that is moving very quickly, the resulting image will be blurred. It is
possible to correct this blurring to a certain extent. Because the optimal type of correction depends on the still
image, we recommend making a copy of the image and experimenting with the copy. It is not possible to
correct for blurring caused by shaking the camera while shooting.

[None]: No correction

[Movement]: Corrects only the blurred portions.

[Field]: Corrects blurring more quickly than [Movement].

[Format]

You can select the file format of an image.
[JPEG]: This is the format that is typically used on the Internet. This format has a smaller file size.
[BITMAP]: This is the standard Windows® image format (BMP). Many applications can use this format.

[JPEG Quality]

This setting is available when JPEG was selected in the [Format] field. Moving the slider to the left makes the
file smaller. Moving the slider to the right results in less deterioration in the image quality. The initial setting is
75.

NOTES:

® When [JPEG] is selected in the [Format] field, the quality of the image deteriorates slightly each time that
[OK] is clicked for the [Image Format] dialog box. To restore the original image quality, reload the original
still image file.

® 7o confirm the file size, right-click the still image and then select [Properties].



RETRIEVING STILL IMAGES FROM AN ALBUM

You can retrieve still images from an album and save them as a file.

1 Select the still image to be retrieved.
® To select more than one still image, hold down the Shift
key or the Ctrl key while clicking the images.
® To select all of the still images, click [Select All] in the
[Edit] menu.

2 Click [Imagel.

The [Image Format] dialog box appears.

3 Change the image format as desired. (= pg. 25, 26)
Then, click [OK].
The [Save As] dialog box appears.
4 Specify the location where you want to save the file,
input the file name, and then click [Save].
The image file is saved.
o If you select more than one still image instep 1, a
confirmation message appears.
* If you want to save all images with the same image
format and their default name, click [Yes]. The [Auto
Save Result] dialog box appears. Then, click [OK].
¢ If you want to set the image format and input file name
for each image, click [No]. The first image is saved. The
[Image Format] dialog box appears for the second
image. Repeat steps 3 and 4 as many times as necessary.

- Digital Photo Navigator
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CREATING A LIST OF STILL IMAGES

You can arrange multiple still images together and save them in a single still image file.

1 Holding down the Shift key or the Ctrl key, select the
still images that are to be added to the list.

2 Click [Multi Image].
The [Multi Image] dialog box appears.

3 Select the number of partitions.
® Either 4, 9, or 16 partitions may be selected.

4 Click [Back Color], select the color for the overall
background, and then click [OK].

5 Change the positions of the still images as desired.
® Deleting an image: Right-click the still image and then
select [Delete].
® Adding an image: Drag an image from the right-hand side
of the Digital Photo Navigator window to the [Multi
Image] dialog box.
6 Click [Save].

The [Image Format] dialog box appears.

7 Change the image format as desired. (= pg. 25, 26)
Then, click [OK].
The [Save As] dialog box appears.

8 Specify the location where you want to save the file,
input the file name, and then click [Save].
The still image list file is saved.
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You can create a slide show or an animation in which a series of still images are displayed, and then save

those images as a movie file (extension “.avi”).

[Slide Show]: Still images are displayed for several seconds each, one at a time.

[Animation]: Several still images are displayed per second. We recommend that you select a series of still

images that create the appearance of continuous movement.
1 Holding down the Shift key or the Ctrl key, select
several still images.
2 Click [Movie].
The [Movie Settings] dialog box appears.

3 Select either [Slide Show] or [Animation], which ever
is desired.

® For a slide show, set the length of the interval (in seconds).

® For an animation, set the number of displayed frames
(images) per second.
4 set the following items when necessary.
® [Image Size]: Select the size of the movie file.
® [Compressor]: Select the type of compressor.
® [Back Color]: This item is used if the aspect ratio of the
images is not 4:3.

S Click [OK].
The [Save As] dialog box appears.

6 Specify the location where you want to save the file, input the file name, and then click [Save].
The movie file is saved, and a confirmation message that asks if you want to play the movie now appears.

7 Click [Yes].
The movie file is played back.
NOTES:

® If you change the [Compressor] item, make sure that the
playback system supports that type of compressor.

® Depending on the selected type for [Compressor], a movie file

cannot be created.

- Digital Photo Navigator

File Edit Impot Export Window Help
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® [n some cases, the settings in the [Video Compression] dialog box are invalid.
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Digital Photo Navigator (Macintosh)

You can capture still images from the recorded camcorder tape, or from the
camcorder in real time. The Digital Photo Navigator software allows you to
store and view still images in the hard disk of the PC.

The icons on the Digital Photo Navigator window have the same functions
as the menus. In this section, almost all the procedures are explained using
the icons.

Read this section if you are using a Macintosh operating system.

Digital Photo Navigator

) il )
= Il )
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Preparation

1 Connect the camcorder to the PC with the PC connection cable and the USB PDA ADAPTER.
® Refer to “CONNECTIONS (Macintosh)” in the Setup Guide.
® Never disconnect the PC connection cable or the USB PDA ADAPTER while Digital Photo Navigator is
running.
2 Open the [Digital Photo Navigator 1.0] folder.
® Close any other programs running on the PC.
® Disable any programs that run in the background, such as screen Digital Photo Navigator 1.0
savers, e-mail applications, virus checkers, schedulers, etc.
® Turn off file and printer sharing.

3 Double-click the [Digital Photo Navigator] icon.
The port selection dialog box appears.

o

]
Digital Photo Mavigator

4 select [Keyspan USB DB9]* for connecting port

and click [OK] Digital Photo Navigator 1.0
Digital Photo Navigator starts. Port selection
o If you start Dlgltal PhOtO NaVigatOl’ at the fi rst time, Please, select conneting port.
a “pictures000” folder for saving images is SR TS e R
automatically created in the [Digital Photo KeyspanUsoBo |5 [__ok |

Navigator 1.0] folder. N )
% Th f . dff d d If not connected to serial device, press "Quit" button.
e name of connecting port may differ depending And, connect it and launch this software again.

on the driver version.
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STARTING DIGITAL PHOTO NAVIGATOR (cont.)

I Digital Photo Navigator window

Previous image in the
folder

Image number (= pg. 33)

First image in the folder

Slow Forward*

Forward Frame Advance*

Counter display

Reverse Frame Advance*

Slow Rewind* \\

I
i

Digital Phoip Navigator

S

\DJ'-—'II'—_*ID &,

“..

rm

=)

Pause (Il)

n (> J>»}

I
&

24| ﬁ,\. .

Rewind (<€«q)

Stop (W)

Play (») Capture (= pg. 34)

Fast Forward (>9>)

* This function is not available with VHS-C camcorders.

NOTES:

Image display (= pg. 33)

Next image in the
folder

Last image in the folder

Photo Capture
(= pg. 36)

Interval Capture
(= pg. 37)

Save As (i pg. 41)

® Use only the operation buttons to control the camcorder. If you operate the camcorder with its own
operation buttons, the appearance may not correspond to the status of the camcorder, or it may cause a
malfunction to occur in Digital Photo Navigator.

® |f an image is captured in the Pause or Slow Play mode, some noise may appear on the captured image. In
this case, capture the image during normal playback.
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Image selection dialog box

If the image number button is clicked, the image selection

dialog box appears. Select the desired folder, input the desired
image number and click [OK]. The specified image is R
displayed. This function is convinient when you open an
already captured image to save it in other directory or in
another file format, or change the image size and save it with imagenumber: | |

different name. (= pg. 41, 42)
=

Image display

Displays the captured image. To display the [Real size image] window, click the image display.

[Real size image] window
You can view the captured image in real size.

Changing the display size of the [Real size image]

window

Select the desired setting from a list of generic sizes of [Image

size] in the [File] menu. Save as PICT...

Save as JPEG...
Save as other ...

age 8 + 640x480
Field mode M 320x240
P 160x120
uit ®
- - 80x60
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I Capturing still images from tape

You can capture still images from the camcorder tape on the PC.

1 Set the Power Switch on the camcorder to “ GER”.
The camcorder is now on.

2 Click the Play (») button.
Playback of the camcorder tape starts.

3 Click the Capture button when the desired image
appears.
The image is transferred to the PC and it is displayed in the

image display after transferring.
® The image file is automatically saved as JPEG format file

in the folder “pictures000”. (MLTeor [> 1) Capture
® The first image file is named “image001” and the number
i i ; i (G Yo )
increases one by one each time new 1rT1ége is .captured. EIERR
4 Repeat steps 2 and 3 to capture additional images. >

I Capturing still inages from the camcorder in real time

You can capture still images in real time, from the camcorder to the hard disk in the PC.

1 Set the Power Switch on the camcorder to “B” or “@".
The camcorder is now on.

2 Click the Capture button when the desired image
appears.
The image is transferred to the PC and it is displayed in the
image display after transferring.
® The image file is automatically saved as JPEG format file

in the folder “pictures000”.

3 Repeat step 2 to capture additional images.

(W]« 001 [» ) Capture
=)
(G Yo )
=)= )
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I Automatic Capture

You can automatically capture still images from the camcorder tape on the PC according to your preferences.
There are 2 ways available: “Photo Capture” and “Interval Capture”.

NOTES:

® Depending on your PC’s specifications and operating environment, the points where images are captured
may not match what was set in the preferences.

® |f the videotape is damaged, the points where images are captured may not match what was set in the
preferences.

® Automatic capture may not function properly if portions of the videotape are unrecorded.

® Automatic Capture may not function properly when, for example, you capture images recorded after the
recording speed was changed. In these cases, capture images by performing the steps in “Capturing still
images from tape” (= pg. 34).

® Automatic capture stops when the number of images in the folder for saving images (such as “pictures001”)
reaches 100 or the videotape ends.

Preparation: Specifying the location where you want to save the images

1 Select [Auto save settings...] in the [Capture] menu. Capture
The [Data save settings] dialog box appears. Take a single image

Interval capture ...
Seeking capture ...

Auto save settings ...

2 Specify the location where you want to save the
images. You have 2 choices. g e setie
When saving the images in a new folder: oG (e TE
Click [Separating folder].
Each time Automatic Capture is performed, a new folder
named “picturesXXX” (The number increases from 001 and - Flace
up to 099) is automatically created in the [Digital Photo ® Separating folder 2
Navigator 1.0] folder. The images are saved in the new (3 Folder fixed
folder.
When saving the images in the “pictures000” folder:
Click [Folder fixed. P T3

® You can select the size of an image to be captured.
(= pg. 39)
3 Click [OK].
After preparations, perform the steps in “Photo Capture” (= pg. 36) or “Interval Capture”. (= pg. 37)
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CAPTURING IMAGES (cont.)

Photo Capture
You can capture only snapshot images recorded on a tape.

1 Click the Photo Capture button.
The [Photo scene search capture setting] dialog box
appears.

2 Select the tape position to start capturing.
® To start capturing from the beginning of the tape: Click
[Beginning of tape].
® To start capturing from the current tape position: Click
[Current position].

3 Select how to stop capturing.

® To capture all the Snapshots to the end of the tape: Click
[End of tape].

® To specify the number of images to be captured: Click
[Reserved times] and then select the number of images.

4 Click [Go ahead].

NOTE:
Photo Capture may not function properly when, for example,

-00:03:48:07F

(G Yo )
=)= )

| __Photo
Capture

Photo scene search capture setting :

— Start position
() Beginning of tape

@ Current position

_ End position

() End of tape

@ Reservedtimes: |1 =

— 4

the camcorder tape includes snapshot images recorded after the recording speed was changed, or when
snapshot images were continuously recorded. In these cases, capture images by performing the steps in

“Capturing still images from tape” (= pg. 34).
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Interval Capture
You can capture images at specified intervals. This function is useful for summarizing the contents of a tape,
or for watching time-lapse movies using the slide show. Also, you can capture a specific subject with subtle
changes over an extended period of time when capturing still images from the camcorder in real time.
[Capturing still images from tape]
1 Click the Interval Capture button.

The [Interval capture setting] dialog box appears.

2 Select [ON (control by tape counter)] for VCR
control.

(KL «To01 [» ) /lnterval
() Capture
050 T (313

=)= )

3 Select the length of the interval (in seconds or

minutes) Interval capture setting :
4 Select the tape position to start capturin e
pep rt capturing. _ ( G —1 3
® To start capturing from the beginning of the tape: Click
[Beginning of tape]. _ VCRcontrol
® To start capturing from the current tape position: Click ® ON (control by tape counter)
[Current position]. 3 OFF (control by timer) 2

5 Select how to stop capturing.
® To stop capturing at the end of tape: Click [End of tape].
® To specify the number of images to be captured: Click
[Reserved times] and then select the number of images.

— Start

) Beginning of tape 4

® Current position

6 Click [Go ahead]. reeeat
) End of tape 5
NOTE: . . . . . @ Reserved times : 1 =
This function doesn’t work if the recording time on the tape is
shorter than 1 minute. Coaneas] L6
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[Capturing still images from the camcorder in real time]

1 Click the Interval Capture button.
The [Interval capture setting] dialog box appears.

2 Select [OFF (control by timer)] for VCR control.

Digital Photo Navigator.

Interval

Capture

sl o)
Sl 1)

3 Select the length of the interval.

® You can select 5 minutes or more for the length of the M o e Y
interval. Interval

4 select the number of images to be captured. ( :’7_ 3

5 Click [Go ahead].

— VCR control
) ON (control by tape counter) 2
@ OFF (control by timer)

 Start

Z) Beginning of tape

(@ Current position

— Repeat

) End of tape

@ Reserved times : 1 B 4

(cance ) ((Gozhead——— 3
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I Changing the transfer speed

The default setting is 57600bps. Depending on the PC in use, transmission errors may occur. In this case,
change to a lower serial speed setting, however, the rate of image transfer will be slower.

1 Select [Transfer speed...] in the [Device] menu.

2 Select the desired setting.
3 Click [OK].

I Changing the image size

You can select the size of an image to be captured.

1 Select [Auto save settings...] in the [Capture] menu.
The [Data save settings] dialog box appears.

2 Select the image size from a list of generic sizes.
3 Click [OK].

NOTE:

You can also change the size of an image after capturing.

(= pg. 42) Note that if an image is enlarged to the size larger
than its original, it will take on a mosaic appearance.

I Changing the connecting port

Device

Connecting Port...

Transfer speed ...

Transfer speed:
=3

Capture
Take a single image

Interval capture ...
Seeking capture ...

Auto save settings ...

Data save settings:

— Image

Save size (pixel): 640x480 % 2

— Place

@ Separating folder

() Folder fixed

() og—-3

If you connect two or more serial devices to the PC, select the connecting port depending on the camcorder

in use.

1 Select [Connecting Port...] in the [Device] menu.

2 Select the desired connecting port.
3 Click [OK].

Device

Connecting Port...
Transfer speed ...

Select connecting port: — 2
313
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1 Select [Quit] in the [File] menu.
Digital Photo Navigator closes. Save as PICT...
Save as IPEG...

Save as other ...

Image size »
Field mode
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I Saving the captured image in other directory

1 Right after capturing an image or displaying the
desired image in the image display (= pg. 32, 33),
click the Save As button.

The [Save] dialog box appears.

2 Specify the location where you want to save the file,
input the file name, and then click [Savel].
The image file is saved.

-00:03:48:07F

=
(G Yo )
=)= ) (Gig—Save As

I Saving the captured image in another file format

PICT format

1 Right after capturing an image or displaying the
desired image in the image display (= pg. 32, 33),
select [Save as PICT...] in the [File] menu.

The [Save] dialog box appears.

Save as PICT...
Save as JPEG...
Save as other ...

. . . Image size )
2 Specify the location where you want to save the file, Field mode b

input the file name, and then click [Savel]. Quit %0
The image file is saved.

Any format other than JPEG or PICT

1 Right after capturing an image or displaying the
desired image in the image display (= pg. 32, 33),
select [Save as other...] in the [File] menu.

The [Save] dialog box appears.

2 Select the desired file format.

File
Save as PICT...
Save as JPEG...
Save as other ...

Image size »
Field mode »

Quit #0Q

3 Specify the location where you want to save the file,
input the file name, and then click [Save].
The image file is saved.
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I Saving the captured image in another image size

1 Right after capturing an image or displaying the 0
desired image in the image display (= pg. 32, 33), Save as PICT...
select the desired setting from a list of generic sizes of cove as PEo-
[Image size] in the [File] menu.

. age size v 640x480
2 Click the Save As button. Select [Save as PICT...] or Fieldmode b 320x240
[Save as other...] in the [File] menu. Quit 20 'g&‘;é"

3 Specify the location where you want to save the file,
input the file name, and then click [Savel].
The image file is saved.

NOTES:

® You can check the selected image size with the [Real size image] window. (= pg. 33) However, close the

[Real size image] window before saving an image.
® Note that if an image is enlarged to the size larger than its original, it will take on a mosaic appearance.

I Saving the captured image after changing the field mode

Normally, captured images are saved in [Dual field mode]. When you shoot a subject that is moving quickly,

it is recommended to select [Single field mode] and save the image.

1 Right after capturing an image or displaying the
desired image in the image display (= pg. 32), select Save as PICT...

[Single field mode] of [Field mode] in the [File] S0 5 I
menu. Save as other ...

2 Click the Save As button. Select [Save as PICT...] or
[Save as other...] in the [File] menu.

Image size »
Field mode } v Single field mode

Quit %0 Dual field mode

3 Specify the location where you want to save the file,
input the file name, and then click [Savel].
The image file is saved.
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Appendix

This appendix contains troubleshooting and index.
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Windows®
SYMPTOM CORRECTIVE ACTION REFER TO:
Although the PC connection | ® Make sure that the AC Adapter is connected to the
cable is connected, Digital camcorder and that the power is on. Setup Guide
Photo Navigator cannot * Make sure that the PC connection cable is connected P
control the camcorder. securely.
The connected camcorder * Make sure that the AC Adapter is connected to the
cannot be detected. The COM | camcorder and that the power .is on. Setup Guide
port cannot be set. * Make sure that the PC connection cable is connected
securely.
o If it is still not detected after clicking [Scan] in the [JLIP pg. 6
Devices] dialog box two or three times, try turning off Setup Guide
your PC and camcorder. Confirm the connection
between them then turn them both back on.
¢ Confirm that the [JLIP Devices] dialog box is operating pg. 6
properly after clicking [Scan]. Setup Guide

¢ If you are using a built-in modem or IrDA, the RS-232C
COM port may occupied. In this case, right-click [My
Computer], then select [Properties]-[System Properties]—
[Device Manager]. Click [Ports (COM & LPT)] to confirm —
which COM port is available. If all the COM ports are
occupied, set the COM port used by the modem or IrDA
driver to [Invalid].

¢ If a USB or Digital Still Camera driver is installed on your
PC, you may not be able to use the RS-232C port.

* Depending on your PC’s specifications, you may need to
change the BIOS settings.

Cannot copy or save files. * Make sure that there is enough free space available in the
drive where you are trying to copy or save a file.

* Make sure that the drive where you are trying to copy or
save a file is not write-protected.

* Make sure that a file with the same name does not
already exist where you are trying to copy or save a file.
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Windows® (cont.)

SYMPTOM CORRECTIVE ACTION REFER TO:
Cannot load still images into | ® Sometimes the format of the still image data prevents it
Digital Photo Navigator. from being loaded into Digital Photo Navigator. Use
other graphics drawing or processing software to convert
the file to either bitmap format or JPEG format. -
* Make sure that there is enough free space available in the
drive in which Digital Photo Navigator is installed.
Still images have a mosaic * When a small image is loaded and enlarged, it will take pg. 19
appearance. on a mosaic appearance.
e If an image is saved with a lower JPEG quality or if the pg. 26
format of the image is changed, it will take on a mosaic
appearance.
The colors displayed on the PC | ® Images will not be displayed correctly if the display is set
are odd. for 256-color (or fewer) display. -
Automatic capture does not ¢ This function may not operate correctly sometimes
function. depending on your PC’s specifications and operating
environment.
* This may occur if correct data is not being transmitted
due to damage on the videotape. —
 There may be software running in the background.
Confirm that there are no programs running in the
background that may be using the processor at the same
time as Digital Photo Navigator.
Communication error occurs | ¢ If the PC connection cable is not connected properly,
in capturing images. communication may be interrupted and error occurs.
(Capturing is interrupted and Disconnect the AC Adapter from the camcorder, connect | Setup Guide
camcorder does not function the PC connection cable properly, and then perform
properly.) capturing again.
NOTE:
When using a laptop PC, operation may be interrupted by a warning when the battery is nearly exhausted.
e If there is software which monitors the status of the battery running in the [StartUp] folder...
Close the application, or delete/move its icon from the [StartUp] folder and reboot your PC.
o If you are using your PC’s power management function...
Right-click the [My Computer] icon, then select [Properties]—[System Properties]—-[Device Manager]—
[System Devices]-[Advanced Power Management Support]. Desactivate the power management
function.
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TROUBLESHOOTING (cont.)

Macintosh
SYMPTOM CORRECTIVE ACTION REFER TO:
Although the PC connection | ® Make sure that the AC Adapter is connected to the
cable is connected, Digital camcorder and that the power is on. Setup Guid
Photo Navigator cannot * Make sure that the PC connection cable is connected etup Luide
control the camcorder. securely.
Cannot copy or save files. * Make sure that there is enough free space available in the
drive where you are trying to copy or save a file.
* Make sure that the drive where you are trying to copy or
save a file is not write-protected. o
* Make sure that a file with the same name does not
already exist where you are trying to copy or save a file.
Automatic capture does not ¢ This function may not operate correctly sometimes
function. depending on your PC’s specifications and operating
environment.
¢ This may occur if correct data is not being transmitted
due to damage on the videotape. —
¢ There may be software running in the background.
Confirm that there are no programs running in the
background that may be using the processor at the same
time as Digital Photo Navigator.
Communication error occurs | ¢ If the PC connection cable is not connected properly,
in capturing images. communication may be interrupted and error occurs.
(Capturing is interrupted and Disconnect the AC Adapter from the camcorder, connect | Setup Guide

camcorder does not function
properly.)

the PC connection cable properly, and then perform
capturing again.
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